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The auris audifi is a WiFi music streamer that works with any amplifier or active speakers to unlock and 
discover a world full of music streaming services and internet radio stations, all streaming in 24-bit Hi-Res 
audio. It can be used as a standalone streamer alongside your preferred amp or grouped with other players to 
create a multi-room listening experience.

1. Introduction

2. What's Inside?

Main Unit x1        

Power Adapter x1       

 User's Manual x1     

Antenna(3dB) x2

2-2RCA Cable x1    
2-1RCA Cable x1   

Remote Control x1  

audifi
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3. Main Features 
- Streaming music via network without distance limitation or Bluetooth 5.0 up to 15 meters.

- Qualcomm® aptX™ HD for true high resolution music. 

- Spotify connect, Airplay, Qplay, DLNA, UPnP streaming protocols supported. 

- Support streaming source from online services, smart device memory, USB pen drive, NAS, Bluetooth and   

line in.

- Multiroom and multizone streaming enabled by mutiple units connected in same network.

- All music sources can be restreamed in sync to other models from us.

- Airplay, Spotify Connect, Qplay, DLNA, UPnP protocol and 3rd party app compatible.

- High quality music streaming support, sample rate decoding up to 24bit / 192kHz. 

- Coaxial and Optical to provide digital audio output.

- Spotify, Deezer, Tidal, Qobuz, iHeartRadio, TuneIn, Napster, lots of online streaming services integrated to use 

in the app.

- Free iOS and Android app available. 

- Free global online update for new features. 

- Full function remote controller to use without cellphone.

- Digital and Analog inputs for more possible external audio input.

- Subwoofer output for external active subwoofer.

- OLED display panel for display info.

- EQ adjustment via app or remote controller. 

- Preset playlist is availble and short buttons on remote controller for one button play.

- iTunes working with PC streaming.
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4. Technical Specifications

 Connectivity

WiFi IEEE 802.11 b/g/n (2.4GHz)

Ethernet Single 10/100M RJ45

Bluetooth Bluetooth 5.0 with Qualcomm® aptX™ HD, AAC ans SBC

USB Host For USB pen drive/stick, 1024 songs limited

 Streaming Protocols AirPlay, DLNA, UPnP, Spotify connect

 D/A Converter ESS SABRE ES9023 DAC

 Frequency Response 20Hz to 20kHz

 Signal to Noise Ratio 110dB

 Total Harmonic Distortion 0.03%

 Audio Outputs

Stereo Analog RCA (2Vrms)

Subwoofer (3.7Vrms)

Digital Optical

Digital Coaxial 

Audio Inputs

Stereo Analog RCA (1.3Vrms)

Digital Optical

Digital Coaxial 
 Power supply 12V/1A

 Audio Decoding Up to 24bit/192kHz

 Audio Formats FLAC, MP3, AAC, AAC+, ALAC, APE, WAV

 Remote IR remote controler

Display Screen OLED display panel

App 4stream App - Free iOS and Android App

 Dimensions 120mm(4.72in) x 37mm(1.46in) x 113mm(4.45in)

 Weight 14.6oz (414gms)
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5. Interface

LED: To show the device status.

Display Panel: Display status info.

IR receiver: Infrared sensor for remote control.

Trigger Out: 12V trigger output used to control or activate other external devices.

Reset Button: Short press to reset the device WiFi, long press to restore the device to factory setting (only 
works in WiFi mode). Please change to WiFi mode when the device is in Bluetooth or Line In mode.

WiFi antenna: External WiFi antenna for better signal strength.

Line In: For external audio sources from TV, CD player and so on.

SubW Out: To connect to any powered (“active”) subwoofer.

Opt In: Digital Optical input to connect to the digital optical output of other compatible devices.

Line Out: To connect to the corresponding analog audio input of any amplifier, receiver or stereo system

Coax Out: Digital Coaxial output to connect to the coax input of compatible devices such as receivers, 

computer soundcards or other digital processors.

Opt Out: Digital Optical output to connect to optical input of other compatible amplifiers or receivers.

LAN: The LAN port to connect to your ethernet broadband router with an ethernet cable.

USB (Type A) : Connect a USB pen drive to the USB input. (1024 tracks limit)

BT Antenna: External Bluetooth antenna for better Bluetooth signal strength.

DC In: 12V/1A DC input.
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6. Remote Control
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8.1  App Download

Download and install the free 4STREAM app from the Apple App Store for iOS or from Google Play for Android. 
This is what you will need to set up and configure audifi.
No need to open this app yet as we first need to connect audifi to your music system.

8. Setup

7. Connection Diagram

Smart Phone Smart Tablet

Windows PC iMAC

Smart Phone Smart Tablet

Windows PC iMAC

Router

Analog device
Audio input RCA

Analog device
Audio output RCA

Digital device audio
Coax/Optical output

Active Subwoofer
RCA

Digital device audio
Optical input

DC input

Internet

Wi-Fi

Ethernet RJ 45 
connect to network

Connect to USB
pen drive

BT ConnnectWi-Fi Connnect

Google Play App Store
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8.2.1  Connecting audifi to your stereo system

8.2  Connection

1. Connect the provided RCA audio cable or your digital Optical/Coaxial cable between audifi and your music 
system or powered speakers.
2. Power audifi with the included power supply. The LED indicator shows “Red” indicating that audifi is in 
standby mode.
3. Turn on your music system and set the volume level so that you can hear the voice and audio prompts during 
the setup.
4. Turn “ON” the audifi device by pressing the power button on the Remote Control or the reset button situated 
at the back of the device.
5. The audifi display will show “Loading”  and in a few seconds a piano tone will play through your music system.
6. The audifi display will then show “Waiting for connection” followed by a voice prompt that will say: “Entering 
setup mode. Follow the instructions in the app to finish the setup.”
Note: If no piano tone or voice is heard after 15 seconds, check your music system volume level.
To go back into setup mode, simply restart the audifi device again by using the Remote Control or the reset 
button at the back of the device.

8.2.2  Connecting audifi via WiFi

1. Connect your mobile device to your WiFi network. 
You’ll need your WiFi password if it’s not already saved on your mobile device.

2. Go to your mobile device WiFi settings and select "SoundSystem_XXXX” from your WiFi list.



8

3. The audio voice will prompt “You are now connected to your speaker. Follow the instructions in the app to 
finish the setup.”
4. Open the installed 4STREAM app onto your iOS or Android device. In the app, you will see the audifi device 
“SoundSystem_XXXX” in the device list. Select the "+" icon at the top right corner of the screen.

5. audifi works on 2.4G, so select 2.4G network from your Wifi list and enter your internet router password if 
prompted to do so.
6. The voice will then prompt “Connected to your Wifi network.” Select “Next”.
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7. Rename your audifi device if you wish to, then select the right arrow at the top of the screen.
8. Go to the browse section in the app and enjoy streaming your favorite tracks to your stereo system.

*Attention for Android users.
Different brand mobile phones may ask you to allow to use SoundSystem WiFi Network. Please select Yes, if 
not, you may not be able to set up successfully. 
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8.2.3 Option 2 - Connecting audifi via LAN 
1. To setup audifi using the LAN port, a wired Ethernet connection is required. Connect one end of the Ethernet 
cable to the LAN port of your Ethernet broadband router and the other end to the audifi's LAN port. The device 
will show on the app in about 10 seconds. 
(Note: Your smartphone and audifi must be on the same WiFi network) 

8.2.4 Option 3 - Connecting audifi via Bluetooth
1. Select Bluetooth from the App (at the bottom of the music Browse page) or simply press “BT” button on the 
Remote Control.
2. The audifi display will show the “Bluetooth icon” indicating that the device is now ready to be paired.
3. Turn “ON” Bluetooth on your device and go to Bluetooth preferences.
4. Scan listed Bluetooth devices and select “SoundSystem” to pair and connect.
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8.3 App Features

8.3.1 Device Settings
	

8.3.2 To Play Local Storage Music
Click “My Music” on the App and choose the music ready there. 
Note: iOS based devices have blocked the access to iTunes library.

Rename: Change the device name.

Speaker info: Display device information like IP address, SSID, firmware version, factory reset, etc.

Alarm Clock: Setup up to 4 different alarm clocks with music of your choice.

Preset Content: 10 Preset content buttons.

Sleep Timer: Countdown to turn off the device.

EQ: Bass and Treble control.
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8.3.3 To Play Music From NAS
Please note that audifi only supports NAS with DLNA feature. 

8.3.4 To Play in Line In Mode
- Connect the provided RCA cables to the TV or 
other audio sources.
- Choose Line In mode on the App or remote 
control.

8.3.5 To Play in Bluetooth Mode
- Choose the Bluetooth mode on the application or 
remote control, the LED will display Bluetooth icon.
- Open the Bluetooth on your smartphone/tablet.
- Pair the device Bluetooth (SoundSystem) and play.
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8.3.6 To Play in Optical In Mode
- Connect the Optical cable to the audio source
- Choose Optical In mode on the application or 
remote control

8.4 Streaming Services
To use the online streaming services like Spotify, Tidal, Qobuz, iHeartRadio, TuneIn and Deezer, you may need 
to register the account at the service provider platform.  
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8.4.2 AirPlay
The device supports AirPlay1. You can choose AirPlay and stream music.

8.4.1 Spotify Connect
audifi supports Spotify Connect, so you can stream music via WiFi directly from the Spotify app. You will find 
the device in the device list in the Spotify app. Simply choose the device you want to play.
NOTE: One Spotify account can only stream to one device at a time.
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8.5 Multiroom and Multizone
Users can group multiroom and multizone on the App. For example, you can group device 1, 2, 3 and 4 together 
and play the same music in sync or group device 1 and 2 as zone A and device 3 and 4 as zone B, and play 
different music in zone A and zone B. 

1 Master

Slave
2

3

Users can choose the right channel or left channel or stereo mode on the application or choose left channel on 
device A and choose right channel on device B, and group them together and play in sync to make stereo.

8.6 Left and Right Channel
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8.8 Source Mode Change 
Method 1: Change on App
Users can change play mode on the application - WiFi, Bluetooth, Line Input, Optical Input and USB. To change 
from Bluetooth/Line Input/Optical Input/USB to WiFi, you only need to choose the online streaming services 
such as Spotify, Qobuz or your smartphone local storage music or any music via DLNA / UPnP streaming.

Method 2: Change with Remote control.
Users can use the remote control to change the play modes - WiFi, Bluetooth, Line Input and USB.

Method 3: Press the Reset button
User can press the reset button once to switch source mode - WiFi, Bluetooth, Line Input and USB.

There are 6 buttons on the remote control, users can preset play lists (only the lists with speaker icon 
can preset) on the application from 1~6 for example, then when you press button 1 on the remote, the preset list 
1 will play. (Users can preset 10 playlists on the application, but the remote control can only save from 1-6).

8.7 Preset
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8.9 Restore Factory Setting
Two methods to restore device to factory setting.
Method 1 - Quickly press the reset button 3 times to restore factory settings.
Method 2 - Go to "App setting → speaker info → restore factory setting".

8.10 Firmware Update
The application will notify you when there is a new firmware version available. It's recommended to update 
the firmware whenever available as this might not only correct bugs or improve security, but also can add new 
features or services.
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9.2 To play music from Windows PC via foobar2000
audifi supports UPnP protocol with the popular foobar2000 player to allow you to seamlessly stream all your 
music from your Windows PC.
1. Download the foobar2000 player from https://www.foobar2000.org/download and install it.
2. Download the DLNA/UpnP plugin for foobar2000 from
https://www.foobar2000.org/components/view/foo_out_upnp
3. Refer to the following link on how to add UPnP component to the foobar200 player
http://wiki.hydrogenaud.io/index.php?title=Foobar2000:How_to_install_a_component 
4. Restart the foobar2000 player and check: Library>configure>output>device. 
You will find the audifi device "SoundSystem" in the device option column. 
5. Choose the device to start streaming your favorite tracks from your Windows PC to your stereo system.

There are several tools to play music from the PC

9. Play on PC

9.1 To play music from iTunes on Mac and Windows PC
audifi can stream from your local storage / media library on Mac or Windows PC and online services from 
iTunes. Users can easily play and switch music, control volume and choose the audio devices to group and 
upgroup the audio devices.
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9.3 To play music from Windows PC via MusicBee
Seamlessly stream music from your Windows PC to audifi with the powerful MusicBee music player.
1. Download the free MusicBee music player from https://www.getmusicbee.com and install it.
2. Download the DLNA/UpnP plugin for the MuiscBee player from 
https://www.getmusicbee.com/addons/plugins/11/upnp-dlna-device-support/
3. Open the MusicBee player and go to Edit>Edit Preferences(Ctrl+O)>Plugins>Add Plugin. Select the 
downloaded DLNA/Upnp plugin file. The musicbee upnp plugin is now installed and will show in the plugin 
section.
4. Now go to Edit>Edit Preferences(Ctrl+O)>Player. Under the audio player section, go to output and select the 
"audifi" device. Click "Apply" and "Save".
5. You are now ready to stream your favorite tracks from your Windows PC to your stereo system.
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10. Web Player Interface

You can access the web player interface by entering the IP address of the device to a web broswer.
*The device IP address can be found by clicking on the Devices setup icon, then select Speaker Info.

The Web Player allows you to control the Volume, Play/Pause, Previous/Next song, Repeat and Shuffle function 
for tracks you're currently streaming or access the preset songs/stations you have setup. You can also change 
the input source of the device.
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In the setup menu, you can do couple of things:
* When entering the setup interface, an admin password is required. The default password is: admin

- Manual update the device firmware
- Change the Device Name
- Setup WiFi connection
- Setup Static IP Address
- Change Admin password

If you want to setup the WiFi connection for the first time without using other method.
1. After you power up the device, connect your mobile/PC WiFi to the device SSID: SoundSystem_xxxx.
2. In the web broswer input 10.10.10.254 (this is the default ip address when there is no network being setup)
3. Go to settings and click on connect button under Connect to AP option.
4. Select the router SSID you want to connect to.
5. Enter the password if required and click on connect button.
6. Now your device is connected to your network, you will need to enter the new ip address to continue to use 
the web player. (since the ip address is not 10.10.10.254 anymore)
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If you have any further questions about the operation or use of this product,
please contact our customer care team for assistance on support@theauris.com

Scan the QR Codes below to explore more

4STREAM app theauris.com Facebook Instagram YouTube
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11. FAQ
Q: Does audifi support Airplay and third-party DLNA apps?
A: Yes. audifi supports Airplay and third-party apps like BubbleUPNP...

Q: How many zones can you group in one system?
A: 12 rooms is the maximum, while 8 zones are recommended.

Q: What distance can audifi cover?
A: Once audifi is connected to your WiFi router, you can stream your music from wherever there is a WiFi signal.

Q: Can it play high resolution music?
A: Yes. audifi can play APE and FLAC within the normal bit rate range. It also supports decoding 24bit/192kHz music files.

Q: How many languages do you support?
A: audifi will auto-detect your mobile device language and change automatically. Currently, we support English, French, 
German, Spanish, Chinese, Portuguese, Korean and Japanese and more on the way.

Q: Can the LED display brightness be controlled?
A: Simply press the LED ON/OFF button on the Remote Control to select brightness from 0% to 100%. The brightness of the 
screen will increase to 100%  when in operation mode, and then dimm to the brightness level selected by you. If the level is set 
to 100%, then it will not dimm at all.

Q: Can I play local music?
A: Yes. You can play music from “MY MUSIC” on the application from local storage devices such as mobile device storage,
USB thumb drives and NAS.

Q: Can the device work with Windows devices?
A: The Windows application is not available at the moment, however on the Windows PC, users can use iTunes, Foobar2000, 
MusicBee and Spotify connect.

Q: Can all music sources play in multiroom mode? 
A: Yes, online streaming music, Line Input and Bluetooth all can play multiroom mode. 

Q: Does audifi support Google Assistant or Alexa? 
A: audifi does not support Alexa. However, through Bluetooth, it can work with Google Assistant. 
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